คู่มือการฝึกอบรมและปฏิบัติงาน
มหาวิทยาลัยเทคโนโลยีราชมงคลอีสาน
ระบบการเงิน

Content
1บทที่ 1 : การสร้างผู้ขายใหม่

1.1 แผนผังการทำงานการสร้างผู้ขายใหม่
1
1.2 การสร้างข้อมูลผู้ขายในระบบ ORACLE
2
บทที่ 2: การสร้างข้อมูลธนาคาร
11
2.1 การเพิ่มธนาคารใหม่
12
2.2 การเพิ่มสาขาของธนาคาร
16
2.2 การเพิ่มเลขบัญชีธนาคาร
21
บทที่ 3: การบันทึกใบแจ้งหนี้โดยตรง (Direct Invoice)
26
2.1 การบันทึกใบแจ้งหนี้
27
2.2 การออกรายงานใบแจ้งหนี้ (Invoice)
33
2.3 การ Validate (อนุมัติใบแจ้งหนี้) ใบแจ้งหนี้ (Invoice)
36
2.4 การสร้างรายการบัญชี (Create Accounting)
39
บทที่ 3 : การบันทึกใบแจ้งหนี้โดยการ Matching ข้อมูลจากระบบจัดซื้อจัดจ้าง
42
บทที่ 4: การจ่ายชำระเจ้าหนี้ (Payment)
51
4.1 การจ่ายชำระเจ้าหนี้ แบบ ขบ 01 ขบ 02 กับ 03
51
4.2 การยกเลิกการจ่ายชำระ (Void Payment)
61
4.3 การยกเลิกใบแจ้งหนี้
66
บทที่ 5: การผ่านรายการบัญชีไปยังบัญชีแยกประเภท (Payable Transfer to GL)
69
5.1 Run Program: Invoice Validation
69
5.2 Run Program: Payables Accounting Process
74
5.3 Run Program: Unaccounted Transaction Report
78
5.4 ตัวอย่างการแก้ไขปัญหา
81
5.5 การผ่านรายการไปยังบัญชีแยกประเภท (Payables Transfer to General Ledger)
88
5.6 การเปิด/ปิดรอบระยะเวลาบัญชี (Periods)
92


บทที่ 1 : การสร้างผู้ขายใหม่
1.1 แผนผังการทำงานการสร้างผู้ขายใหม่
PO-RF-01: 
การสร้างผู้ขายใหม่
หน่วยงาน:
แผนกพัสดุ
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1.2 การสร้างข้อมูลผู้ขายในระบบ ORACLE

การสร้างข้อมูลผู้ขาย แบ่งออกเป็น 2 ระดับ คือ Supplier Header และ Supplier Site ข้อมูลที่สร้างในระดับ Supplier Header จะเป็นค่า default ของ Supplier Site โดยระบบ Oracle Purchasing จะใช้ข้อมูลของ Supplier Site เป็น default เวลาทำรายการในระบบ และถ้ามีการเปลี่ยนแปลงข้อมูลของ Supplier Site ระบบจะไม่เปลี่ยนแปลงข้อมูลย้อนหลังสำหรับรายการที่ได้ทำไปแล้ว
Responsibility: ระบบจ่ายชำระเงิน
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Supplier Header
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Supplier Name:
ระบุชื่อ Supplier

Supplier Number:
ระบุรหัส Supplier โดยจะใช้เลขประจำตัวผู้เสียภาษี 
กรุณาระบุรายละเอียดรหัสผู้ขายในระบบ GFMIS:  ระบุเลขประจำตัวผู้ขายในระบบ GFMIS
Inactive On:
ระบุวันที่ (กรณีเลิกใช้)
Tab General:
เป็นข้อมูลรายละเอียดทั่วไป
Parent Supplier Name, Number:
ระบุชื่อบริษัทแม่ของ Supplier (ถ้ามี)
Tab Invoice Tax
ไม่สามารถระบุที่ระดับ Supplier Header ต้องระบุที่ระดับ Supplier Site
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Tab Withholding Tax
เป็นข้อมูลเกี่ยวกับการหักภาษี ณ ที่จ่าย
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Allow Withholding Tax:
คลิ๊ก กรณีต้องมีการหักภาษี ณ ที่จ่าย

Withholding Tax Group:
ระบุค่า Default ของอัตราภาษีหัก ณ ที่จ่าย
Supplier Site
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หน้าจอ Supplier Site
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Tab General
เป็นข้อมูลทั่วไปของ Supplier Site
Site Name:
ระบุ “ชื่อวิทยาเขต” เป็นชื่อ Supplier Site 

Country:
ระบุประเทศ
Address:
ระบุที่อยู่

City:
ระบุอำเภอ / เขต

Postal Code:
ระบุรหัสไปรษณีย์

Province:
ระบุจังหวัด
Site Uses:
คลิ๊กเพื่อระบุวัตถุประสงค์ของ Site นี้

Pay:
ใช้สำหรับจ่ายชำระเงิน


Purchasing:
ใช้สำหรับสั่งซื้อ

Communication
ระบุหมายเลขโทรศัพท์ที่ใช้ติดต่อ และ e-mail address (ถ้ามี)

Tab Accounting
เป็นข้อมูลรหัสบัญชี
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Liability:
ระบุรหัสบัญชีเจ้าหนี้การค้า 
Prepayment:
ระบุรหัสบัญชีเงินทดรองจ่าย 
Tab Invoice Tax
เป็นข้อมูลเกี่ยวกับภาษีมูลค่าเพิ่ม
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Invoice Tax Code:
ระบุรหัสภาษีมูลค่าเพิ่ม (VAT) กรณีผู้ขายรายที่มีการคิดภาษีมูลค่าเพิ่ม หากผู้ขายรายใดที่ไม่คิดภาษีมูลค่าเพิ่มก็ไม่ต้องระบุ
Calculation Level:
เลือก Line เพื่อให้ระบบคำนวณภาษีมูลค่าเพิ่ม (VAT) อัตโนมัติ

Allow Calculation Level Override:
ระบบจะคลิ๊กให้อัตโนมัติ
Rounding Rule:
เลือก Nearest เพื่อคำนวณการปัดเศษทศนิยม

Distribution Amounts Include Tax:
ระบบจะคลิ๊กให้อัตโนมัติ
คลิ๊ก Save
เพื่อบันทึกข้อมูล

Tab Purchase
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Ship-To Location: 
สถานที่ส่งของ
Bill-To Location:
สถานที่เก็บเงิน
บทที่ 2: การสร้างข้อมูลธนาคาร
การสร้างข้อมูลธนาคาร แบ่งเป็น 3 แบบ คือ การเพิ่มธนาคารใหม่, การเพิ่มสาขาของธนาคารเดิม และการเพิ่มเลขบัญชีธนาคาร
หมายเหตุ ข้อมูลเลขที่บัญชีธนาคารที่เพิ่มเข้าไปในระบบต้องได้รับการเพิ่มข้อมูลทางการบัญชีจากฝ่ายบัญชีก่อน 
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2.1 การเพิ่มธนาคารใหม่ 
[image: image14.png]© Banks (NR Operating Uni)
Bank

Narme.

rrc identiier (| D
nactive On (NN

Address ~)

City

Province

Bank Branch
Narme.

Alternate Name

Nurnber

Type

EDI D Nurnber
EDI Location
EFT Number

BIC

State
County
Postal Code

Altemate
Address

. u
Jated Bani Click [





Bank Name:

ระบุชื่อธนาคาร
Bank Branch Name:
ระบุชื่อสาขาธนาคาร
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Bank Accounts Name: 
ระบุเลขบัญชีธนาคาร
Account Use:


ระบุ Internal
Bank Accounts Number: 
ระบุเลขบัญชีธนาคาร
Currency:


ระบุ THB


Description:


ระบุคำอธิบายหรือวัตถุประสงค์ของบัญชีธนาคารนี้
Account Type:


ระบุประเภทเงินฝาก เช่น กระแสรายวัน หรือออมทรัพย์ 
TAB GL Accounts
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Cash: 


ระบุรหัสบัญชีเงินฝาก
Cash Clearing:
ระบุรหัสบัญชีเงินฝาก
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TAB More Receivable
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Unapplied Receipts:

ระบุบัญชีเงินรับฝากอื่น 
Unidentified Receipts:
ระบุบัญชีเงินรับฝากอื่น 
On Account Receipts:

ระบุบัญชีเงินรับฝากอื่น
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Unearned Discounts:

 ระบุ Unearned Discounts
Earned Discounts:

 ระบุ Earned Discounts
Payables Documents

TAB Document Information
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Document Name:

ระบุชื่อธนาคาร
Disbursement Type:

ระบุ Combined

Payment Format:

ระบุ Standard Check Format
TAB Additional Information
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Document Number
Last Used: 

ระบุเลขที่เช็คที่จะเริ่มใช้ 
Last Available:
ระบุเลขที่เช็คใบสุดท้ายที่จะใช้
คลิก
[image: image22.bmp] (Save)
2.2 การเพิ่มสาขาของธนาคาร

จะเกิดในกรณีที่ในระบบมีข้อมูลของธนาคารดังกล่าวอยู่แล้ว เพียงแต่ยังไม่มีสาขาที่ผู้ใช้งานต้องการใช้ จึงต้องเพิ่มสาขาดังกล่าวเข้าสู่ระบบ

ตัวอย่าง 
ในระบบมีข้อมูลธนาคารกสิกรไทยอยู่แล้ว แต่ยังไม่มีสาขากรุงเทพมหานคร ต่อมาทางมหาวิทยาลัยได้เปิดบัญชีกับทางธนาคารกสิกรไทย สาขากรุงเทพมหานคร จึงต้องเพิ่มข้อมูลสาขานี้เข้าสู่ระบบ
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Bank Name:

ระบุชื่อธนาคาร
Bank Branch Name:
ระบุชื่อสาขาธนาคาร
Bank Accounts
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Bank Accounts Name: 
ระบุเลขบัญชีธนาคาร
Account Use:


ระบุ Internal
Bank Accounts Number: 
ระบุเลขบัญชีธนาคาร
Currency:


ระบุ THB


Description:


ระบุคำอธิบายหรือวัตถุประสงค์ของบัญชีธนาคารนี้
Account Type:


ระบุประเภทเงินฝาก เช่น กระแสรายวัน หรือออมทรัพย์ 
TAB GL Accounts
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Cash: 


ระบุรหัสบัญชีเงินฝาก
Cash Clearing:
ระบุรหัสบัญชีเงินฝาก
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TAB More Receivable

[image: image27.png]71X

Bank ame YT YT Banch Name

Bank Accounts

(1702136437 5
THB

Al 2 ezt Gl

GL Accounts | Account Contact | Account Holder | Receivables O,

GL Accourt Description
[V 01.000.0000.000.21110201 X~ f1amss215:.000.0000.000.

Unidentified Receipts [01.000.0000.000.2111020199.00000.0001 g5 245 2.000.0000.000.
On Account Receipts [01.000.0000.000.2111020199.00000.000i ass 1260 1.000.0000,000.

Receivables Actities Description
Unearned Discounts |Uneamed Discount [unearned Discount

Eamed Discounts [Earned Discount [Earned Discount

Payables Documents Bark Codes




Unapplied Receipts:

ระบุบัญชีเงินรับฝากอื่น 
Unidentified Receipts:
ระบุบัญชีเงินรับฝากอื่น 
On Account Receipts:

ระบุบัญชีเงินรับฝากอื่น
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Unearned Discounts:

 ระบุ Unearned Discounts
Earned Discounts:

 ระบุ Earned Discounts
Payables Documents

TAB Document Information
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Document Name:

ระบุชื่อธนาคาร
Disbursement Type:

ระบุ Combined

Payment Format:

ระบุ Standard Check Format

TAB Additional Information
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Document Number

Last Used: 

ระบุเลขที่เช็คที่จะเริ่มใช้ 
Last Available:
ระบุเลขที่เช็คใบสุดท้ายที่จะใช้
คลิก
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2.2 การเพิ่มเลขบัญชีธนาคาร

ใช้ในกรณีที่ต้องการเพิ่มเลขที่บัญชีธนาคารสำหรับธนาคารและสาขาที่มีข้อมูลอยู่ในระบบแล้ว

ตัวอย่าง 
ในระบบมีข้อมูลธนาคารกสิกรไทย สาขานครราชสีมาอยู่แล้ว แต่ยังไม่มีข้อมูลเลขที่บัญชี 702-9-99999-9 

- ดึงข้อมูลธนาคาร สาขาที่จะเพิ่มเลขที่บัญชีธนาคาร
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- จะปรากฎข้อมูลเลขที่บัญชีธนาคารเดิมที่มีอยู่แล้ว ถ้าต้องการเพิ่มข้อมูลใหม่คลิก [image: image33.bmp] (New)
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- ระบุข้อมูลที่จำเป็นต่าง ๆ (วิธีการคล้ายกับ 2 วิธีแรกสำหรับการกรอกข้อมูล)
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การบันทึกบัญชี Cash and Cash Clearing
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Payables Documents

TAB Document Information

[image: image39.png]© Payment Documents (NR Operating Unif) - suw

Document Information | Additional Infarmation

Disbursement
Document Narme Type

6L Accounts

Payment
Format

Future Dated Payments.

Payment
Method

Inactive
on

Jlomensnanstne [combined

[Standard Check F[Check

{0 [ I [ I ¢

<

D





TAB Additional Information
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Document Number

Last Used: 

ระบุเลขที่เช็คที่จะเริ่มใช้ 
Last Available:
ระบุเลขที่เช็คใบสุดท้ายที่จะใช้
คลิก
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บทที่ 3: การบันทึกใบแจ้งหนี้โดยตรง (Direct Invoice)
Flow การเบิกจ่าย กรณีำไม่มีใบสั่งซื้อ
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การบันทึกใบแจ้งหนี้โดยตรง (Direct Invoice) เป็นการบันทึกใบแจ้งหนี้ที่ไม่ได้มาจากการ Matching จากระบบ Oracle Purchasing ซึ่งการบันทึกจะบันทึกเป็นแบบ Batch โดยแยก Batch แยกเป็นครั้งในการตั้งเบิกในเดือนนั้นๆ
2.1 การบันทึกใบแจ้งหนี้
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N -> บันทึกใบแจ้งหนี้ -> บันทึกใบแจ้งหนี้ -> สร้างกลุ่มใบแจ้งหนี้
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Batch Name
ตั้งชื่อ Batch แล้วคลิ๊ก Invoices
หลักในการตั้งชื่อ Batch(กลุ่มใบแจ้งหนี้)
1. ระบุอักษรภาษาอังกฤษตัวพิมพ์ใหญ่ 1 ตัวอักษรที่เป็นชื่อย่อของผู้ที่กรอกข้อมูลใน Batchดังกล่าว เช่น T มาจาก Test
2. ระบุปีงบประมาณของหน่วยงาน เช่น 49 (ปีงบประมาณปัจจุบัน)
3. ระบุเดือนที่เกิดรายการ เช่น 07 มาจากเดือนกรกฎาคม
Invoice Header
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Type  [inwd@m | Supplier Supplier Nurm Site Invoice Date | Invoice Num | Invoice Amour| GL Date Tax Code U (GF|

gl T D

1 General 2 Holds 3 View Payments | 4 Scheduled Payments | 5 View Prepayment Applications

-Amount Paid Invoice Status Approval Status

[mB | 0.00 Status |Never Validated Approval |Not Required
Accounted |No Pending Approver

Summary

Descriti
escription .

Distribution Total 0.00

Actions._. 1 Qernview Distributions Purchase Order | Match




Type
ระบุประเภทของ Invoice ดังต่อไปนี้

Standard
เป็น Invoice ทั่วไป

Credit Memo
Credit Notes


Debit Memo
Debit Notes

Expense Report
กรณีบุคลากรขอเบิกเงินที่ได้สำรองจ่ายไปก่อน จากการไปราชการ

Prepayment
กรณีเป็น Prepayment หรือ เงินทดรองจ่าย

QuickMatch
กรณีต้องการทำ Matching กับ PO โดยให้ระบบ Auto Check ให้แต่ละรายการที่ต้องการซื้อ
เลขที่ฎีกา

ระบุเลขที่ฎีกา
Supplier/Supplier Number
ระบุชื่อ Supplier
Site
ระบบจะแสดง Site ของหน่วยงานให้อัตโนมัติ
Invoice Date
ระบุวันที่ใบแจ้งหนี้
Invoice Number
ระบุเลขที่ใบแจ้งหนี้ (เลขที่ใบแจ้งหนี้สำหรับ Supplier เดียวกัน ไม่สามารถซ้ำได้)
Invoice Current
ระบุสกุลเงินของใบแจ้งหนี้
Invoice Amount
ระบุจำนวนเงิน
GL Date
ระบุวันที่ลงบัญชี (ระบบจะ default GL Date จากวันที่รับของหรือวันที่ใบแจ้งหนี้)
Tax Code
ระบบจะ default ข้อมูล Tax Codeจาก Supplier Site เพื่อให้ระบบคำนวณภาษีมูลค่าเพิ่มอัตโนมัติ (ต้องระบุก่อน save ข้อมูล) หากผู้ขายรายใดไม่คิดภาษีมูลค่าเพิ่มข้อมูลในช่องดังกล่าวจะว่าง กรณีผู้ขายดังกล่าวคิดภาษีมูลค่าเพิ่มแต่ระบบไม่ระบุให้อัตโนมัติให้กลับไปดูที่ข้อมูลผู้ขายแล้วแก้ไขให้ผู้ขายรายดังกล่าวคิดภาษีมูลค่าเพิ่มก่อนทำการ save ข้อมูลการบันทึกใบแจ้งหนี้
เลขที่บส.(GFMIS)
ระบุเลขเลขที่บส. ในระบบ GFMIS
Withholding Tax Group
ระบุรหัสภาษีหัก ณ ที่จ่าย (ถ้ามี) ระบบจะ default Withholding Tax Group จาก Supplier Site
คลิ๊ก Distributions
ระบบจะบันทึกข้อมูล และเข้าสู่หน้าจอเพื่อบันทึกรายละเอียดใบแจ้งหนี้แต่ละบรรทัด (Invoice Lines)
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Amount
ระบุจำนวนเงินยอดรวมในใบแจ้งหนี้
Account
ระบุรหัสบัญชี (บัญชีด้านเดบิท)
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Tax Code
ระบบจะ default ข้อมูล Tax Codeจาก Supplier Site 
Withholding Tax Group
ระบุรหัสภาษีหัก ณ ที่จ่าย (ถ้ามี) ระบบจะ default Withholding Tax Group จาก Supplier Site
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Description
ระบุรายละเอียดของใบแจ้งหนี้แต่ละบรรทัด (ระบบจะ default Description จาก Invoice Header)

Click Save
เพื่อบันทึกข้อมูลลงในระบบ

หมายเหตุ
ถ้าจำนวนเงินใน Invoice Distributions ไม่เท่ากับ Invoice Header เวลา Approve Invoice จะติด “Invoice on Distribution Variance hold”
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วิธีการเพิ่ม Line ในการบันทึกใบแจ้งหนี้ใหม่ใน Batch ที่ทำงานอยู่ คือ 
· คลิ๊กที่  [image: image52.png]


 หรือ
· กดลูกศรเลื่อนลงจากแป้นพิมพ์ (Key Board)
2.2 การออกรายงานใบแจ้งหนี้ (Invoice) 

การออกรายงานใบแจ้งหนี้ทำเพื่อตรวจสอบความถูกต้องของข้อมูลในใบแจ้งหนี้ก่อนการ Approve
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เมื่อ Phase = Completed และ Status = Normal คลิ๊ก View Output

2.3 การ Validate (อนุมัติใบแจ้งหนี้) ใบแจ้งหนี้ (Invoice)
เมื่อบันทึกใบแจ้งหนี้แล้ว ให้ทำการ Validate ใบแจ้งหนี้ (ถ้าไม่ Validate ใบแจ้งหนี้ ระบบจะไม่สามารถทำการจ่ายชำระและผ่านข้อมูลไปยังระบบ Oracle General Ledger ได้)
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คลิ๊ก OK
MENU -> View -> Requests 
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เมื่อ Phase = Completed และ Status = Normal คลิ๊ก View Output
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หน้าจอแสดงผลการ Validate
2.4 การสร้างรายการบัญชี (Create Accounting)

การสร้างรายการบัญชีสำหรับใบแจ้งหนี้ (Create Accounting) มีประโยชน์ในการตรวจสอบรายการบัญชีสำหรับใบแจ้งหนี้ใบนั้น ก่อนที่จะทำการส่งข้อมูลไปยังระบบ Oracle General Ledger จะต้องทำการสร้างรายการบัญชีก่อน ไม่เช่นนั้นรายการบัญชีสำหรับใบแจ้งหนี้นั้นจะไม่ถูกส่งไปยังระบบ Oracle General Ledger
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MENU -> View -> Requests 
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คลิ๊ก Find
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เมื่อ Phase = Completed และ Status = Normal คลิ๊ก View Output

หน้าจอแสดงผลการสร้างรายการบัญชี
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เมื่อคลิ๊กที่ Next ระบบจะแสดงผลการสร้างรายการบัญชีซึ่งสามารถพิมพ์ออกมาเพื่อตรวจสอบการบันทึกรายการบัญชีได้

[image: image74.png]© Repart: requ:

Report Date: 21-JUL-20)
Page:
>
set of Books: wi.Amu - ueTIERAD
>
Accounting Entries Audit Reportd
>
gournal Category: Purchase Invoices)
>
sccount ingd

pate Event Type Supplier Newe Document Nun  Voucher Num

ecount curr DR cr DR

20-UL-06  Invoice U 1. duRe. BEUR TV4s06371 1508/ 499

1 Charge 01.213.1703.000.5104 THB 57,616.82 57,616.82)
2 Nonrecoversble Tax 01.213.1703.000.5104 THB 4,093.18 4,093,180
3 Lisbility 01.000.0000.000.2101  THB 61,650.00

20-UL-06  Invoice U 1R BdUE 14906372 1515/49)

1 Charge 01.213.1703.000.5104 THB 61,822.43 61,822.43)

2 Nonrecoversble Tax .213.

nnn.anan.ann

1703.000.5104 4,327,

Brevious




บทที่ 3 : การบันทึกใบแจ้งหนี้โดยการ Matching ข้อมูลจากระบบจัดซื้อจัดจ้าง
Flow AP-RF-01 – การเบิกจ่ายเงิน – กรณีมีใบสั่งซื้อ และใช้ ขบ.01
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การบันทึกใบแจ้งหนี้โดยการ Matching ใบสั่งซื้อจากระบบ Oracle Purchasing (Matching Invoice) เป็นการบันทึกใบแจ้งหนี้โดยรับข้อมูลและรายละเอียดต่าง ๆ มาจากระบบ Oracle Purchasing ซึ่งจะสะดวกต่อการปฏิบัติงาน และสามารถควบคุมความถูกต้องของข้อมูล โดยการบันทึกจะบันทึกเป็นแบบ Batch เช่นเดียวกับการบันทึกใบแจ้งหนี้โดยตรง Direct Invoice โดยแยก Batch ตามผู้บันทึกและวันที่บันทึก
N -> บันทึกใบแจ้งหนี้ -> บันทึกใบแจ้งหนี้ -> สร้างกลุ่มใบแจ้งหนี้
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Batch Name
ตั้งชื่อ Batch แล้วคลิ๊ก Invoices
หลักในการตั้งชื่อ Batch(กลุ่มใบแจ้งหนี้)
1. ระบุอักษรภาษาอังกฤษตัวพิมพ์ใหญ่ 1 ตัวอักษรที่เป็นชื่อย่อของผู้ที่กรอกข้อมูลใน Batchดังกล่าว เช่น T มาจาก Test
2. ระบุปีงบประมาณของหน่วยงาน เช่น 49 (ปีงบประมาณปัจจุบัน)
3. ระบุเดือนที่เกิดรายการ เช่น 07 มาจากเดือนกรกฎาคม
Invoice Header
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-Amount Paid Invoice Status Approval Status

[mB | 0.00 Status |Never Validated Approval |Not Required
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Summary
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escription .

Distribution Total 0.00
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Type
ระบุประเภทของ Invoice ดังต่อไปนี้

Standard
เป็น Invoice ทั่วไป

Credit Memo
Credit Notes


Debit Memo
Debit Notes

Expense Report
กรณีบุคลากรขอเบิกเงินที่ได้สำรองจ่ายไปก่อน จากการไปราชการ

Prepayment
กรณีเป็น Prepayment หรือ เงินทดรองจ่าย

QuickMatch
กรณีต้องการทำ Matching กับ PO โดยให้ระบบ Auto Check ให้แต่ละรายการที่ต้องการซื้อ
เลขที่ฎีกา

ระบุเลขที่ฎีกา
Supplier/Supplier Number
ระบุชื่อ Supplier

Site
ระบบจะแสดง Site ของหน่วยงานให้อัตโนมัติ
Invoice Date
ระบุวันที่ใบแจ้งหนี้
Invoice Number
ระบุเลขที่ใบแจ้งหนี้ (เลขที่ใบแจ้งหนี้สำหรับ Supplier เดียวกัน ไม่สามารถซ้ำได้)
Invoice Current
ระบุสกุลเงินของใบแจ้งหนี้
Invoice Amount
ระบุจำนวนเงิน
GL Date
ระบุวันที่ลงบัญชี (ระบบจะ default GL Date จากวันที่รับของหรือวันที่ใบแจ้งหนี้)
Tax Code
ระบบจะ default ข้อมูล Tax Codeจาก Supplier Site เพื่อให้ระบบคำนวณภาษีมูลค่าเพิ่มอัตโนมัติ (ต้องระบุก่อน save ข้อมูล) หากผู้ขายรายใดไม่คิดภาษีมูลค่าเพิ่มข้อมูลในช่องดังกล่าวจะว่าง กรณีผู้ขายดังกล่าวคิดภาษีมูลค่าเพิ่มแต่ระบบไม่ระบุให้อัตโนมัติให้กลับไปดูที่ข้อมูลผู้ขายแล้วแก้ไขให้ผู้ขายรายดังกล่าวคิดภาษีมูลค่าเพิ่มก่อนทำการ save ข้อมูลการบันทึกใบแจ้งหนี้
เลขที่บส.(GFMIS)
ระบุเลขเลขที่บส. ในระบบ GFMIS
Withholding Tax Group
ระบุรหัสภาษีหัก ณ ที่จ่าย (ถ้ามี) ระบบจะ default Withholding Tax Group จาก Supplier Site
กรณีผู้ขายไม่ได้จดทะเบียนภาษีมูลค่าเพิ่ม
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คลิ๊ก Match
ระบบจะบันทึกข้อมูล และเข้าสู่หน้าจอเพื่อระบุเลขที่ Purchase Order
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PO Number
ระบุเลขที่ PO แล้วคลิ๊ก Find
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คลิ๊ก Distributions
เพื่อตรวจสอบข้อมูลให้ถูกต้องและระบุรายละเอียดเพิ่มเติมเกี่ยวกับภาษีมูลค่าเพิ่ม/ภาษีหัก ณ ที่จ่าย (ถ้ามี)
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กรณีผู้ขายจดทะเบียนภาษีมูลค่าเพิ่ม
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คลิ๊ก Distributions
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คลิ๊ก Calculate Tax
เพื่อให้ระบบคำนวณภาษีให้อัตโนมัติ
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บทที่ 4: การจ่ายชำระเจ้าหนี้ (Payment)

4.1 การจ่ายชำระเจ้าหนี้ แบบ ขบ 01 ขบ 02 กับ 03
การจ่ายชำระเจ้าหนี้สามารถทำได้เมื่อใบแจ้งหนี้นั้นถูก Approve แล้ว และไม่ติด Hold
N -> บันทึกใบแจ้งหนี้ -> บันทึกใบแจ้งหนี้ -> สร้างกลุ่มใบแจ้งหนี้
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หมายเหตุ ใช้คำสั่ง  Ctrl + F11 ในการค้นหา Batch ที่ต้องการจ่ายเงิน
หรือใช้คำสั่ง F11 แล้วพิมพ์ชื่อ Batch ที่ต้องการจ่ายเงิน ตามด้วยคำสั่ง Ctrl + F11 ระบบจะทำการค้นหา Batch ที่ต้องการให้
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ข้อสังเกตุ  ก่อนทำการจ่ายเงิน Invoice Status จะต้องมี Status = Validated และ Accounted = Yes ซึ่งหมายความว่า ได้ทำการ Validate ใบแจ้งหนี้นี้และได้ทำการบันทึกตั้งหนี้เรียบร้อยแล้ว
Action -> Pay in Full 
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เลือก OK
การจ่ายชำระเจ้าหนี้แบบ ขบ 01
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หมายเหตุ: เลือกประเภทงบประมาณที่ใช้ให้ถูกต้อง
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คลิ๊ก OK

[image: image96.png]Type |Bank Account || Document | Document Num ||Payment Date | Supplier Supplier Num Supplier Site Paymi
Quick |#u. 01 - Fuovdsafny. 01 - sulss| 1000467 p7-mar 2007l B TRt 3309900373318 P a1
T szundiipaasinluu ol flisaluia

zuiufihaiufszuue: Defalt fusiiloaiiuly)

Il

Iimice Oyerview.

No

Actions._ 1 Enter/Adjist [mices View Brocesees Payrert Oveniew

D




Bank Account
ระบุธนาคารที่จะทำการจ่ายชำระ
Document
ระบุชุดเช็คที่จะจ่าย (สร้างชุดเช็คที่หน้าจอ set up bank)

Document Number
ระบบจะให้หมายเลขเช็คอัตโนมัติจากชุดเช็คที่จ่าย
Payment Date
ระบุวันที่ที่จะจ่ายชำระ (โดยจะต้องเป็น period ที่เปิดอยู่) และระบบจะใช้ Payment Date เป็น GL Date
Payment Amt
ระบุจำนวนเงินที่จะจ่าย (ระบบจะดึงข้อมูลมาจากใบแจ้งหนี้)
Supplier
ระบุ Supplier (ระบบจะดึงข้อมูลมาจากใบแจ้งหนี้)
คลิ๊ก    
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เลือก Actions   -> Create Accounting
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เลือก OK
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Review Accounting

Tools -> view accounting
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การจ่ายชำระเจ้าหนี้แบบ ขบ 02 03
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ระบุ Supplier (ระบบจะดึงข้อมูลมาจากใบแจ้งหนี้)
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คลิ๊ก  
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 เพื่อ Save ข้อมูล
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เลือก Actions   -> Create Accounting
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เลือก OK
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Review Accounting

Tools -> view accounting
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4.2 การยกเลิกการจ่ายชำระ (Void Payment)

การยกเลิกการจ่ายชำระ (Void) สามารถทำได้ ไม่ว่ารายการชำระนั้นจะถูกสร้างรายการบัญชี (Create Accounting) หรือผ่านรายการบัญชี (Posted) ไปแล้วก็ตาม

เมื่อทำการยกเลิกการจ่ายชำระ (Void) แล้ว จะไม่สามารถทำรายการใด ๆ สำหรับรายการนั้นได้อีก

N -> บันทึกจ่ายเงิน -> บันทึกการจ่ายเงิน -> จ่ายเงิน
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ใช้คำสั่ง  ctrl + F11
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N -> Actions -> Void 
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คลิ๊ก Void
เพื่อทำการยกเลิกการจ่ายชำระ
Date
ระบุวันที่ทำการ Void (ระบบจะ default วันที่ปัจจุบัน)
GL Date
ระบุวันที่บันทึกบัญชี (ระบบจะ default วันที่ปัจจุบัน)
คลิ๊ก OK
ระบบจะทำการยกเลิกการจ่ายชำระ
หมายเหตุ
ควรตรวจสอบ GL Date ให้ถูกต้องก่อนคลิ๊ก OK โดยเฉพาะการ Void รายการชำระเงินของรอบระยะเวลาบัญชีที่แล้ว เนื่องจาก GL Date จะ default รอบระยะเวลาบัญชีปัจจุบัน
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เลือก Actions   -> Create Accounting
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เลือก OK

Review Accounting

Tools -> view accounting
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4.3 การยกเลิกใบแจ้งหนี้

การยกเลิกใบแจ้งหนี้ สามารถทำได้ ไม่ว่าใบแจ้งหนี้นั้นจะถูก Validate, สร้างรายการบัญชี (Create Accounting) หรือผ่านรายการบัญชี (Posted) ไปแล้วก็ตาม แต่ถ้ามีการทำการจ่ายชำระไปแล้วจะไม่สามารถทำการยกเลิกใบแจ้งหนี้ได้ ต้องไปทำการยกเลิกการจ่ายชำระ (Void) ก่อนถึงจะทำการยกเลิกใบแจ้งหนี้ได้


เมื่อทำการยกเลิกใบแจ้งหนี้แล้ว จะไม่สามารถทำรายการใด ๆ สำหรับใบแจ้งหนี้นั้นได้อีก

N -> บันทึกใบแจ้งหนี้ -> บันทึกใบแจ้งหนี้ -> สร้างกลุ่มใบแจ้งหนี้
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หมายเหตุ ใช้คำสั่ง  Ctrl + F11 ในการค้นหา Batch ที่มีรายการที่ต้องยกเลิก
หรือใช้คำสั่ง F11 แล้วพิมพ์ชื่อ Batch ที่มีรายการที่ต้องยกเลิก ตามด้วยคำสั่ง Ctrl + F11 ระบบจะทำการค้นหา Batch ที่ต้องการให้
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N -> Actions -> Cancel Invoices 
[image: image122.png]Batch Cantrol Total © Invaice Actions.

L2
W\slidate Related Invoices

iCancel inoices
B Aply/Unapply Prepayment
gy in Full

Hold Narme

Release Name
~Amount Pai

THB

Release Reason

WPrint Notice Printer
Sender Name

Sender Title
Jiption 5745321786 ender Tile

60,000.00

>





คลิ๊ก Cancel Invoices

เพื่อทำการยกเลิกใบแจ้งหนี้
หมายเหตุ
1.
เมื่อทำการยกเลิกใบแจ้งหนี้แล้ว จะต้องมีการสร้างรายการบัญชีอีกครั้ง

2.
GL Date ของรายการยกเลิกใบแจ้งหนี้จะเป็นวันเดียวกับใบแจ้งหนี้ แต่ถ้ารอบระยะเวลาบัญชีนั้นปิดแล้ว GL Date จะเป็นวันที่ 1 ของรอบระยะเวลาบัญชีถัดไป
ข้อจำกัดการยกเลิกใบแจ้งหนี้
1.
ใบแจ้งหนี้ที่ทำการจ่ายชำระไปแล้วจะไม่สามารถทำการยกเลิกใบแจ้งหนี้ได้ ต้องไปทำการยกเลิกการจ่ายชำระ (Void) ก่อนถึงจะทำการยกเลิกใบแจ้งหนี้ได้
2. ใบแจ้งหนี้ที่ได้ Apply Prepayment แล้วจะไม่สามารถทำการยกเลิกใบแจ้งหนี้ได้ ต้องไปทำการ Unapply ก่อน
3. ใบแจ้งหนี้แบบ Prepayment ที่ได้ Apply ใบแจ้งหนี้แล้วก็ไม่สามารถทำการยกเลิกได้ ต้องไปทำการ Unapply และยกเลิกการชำระ (Void) Prepayment นั้นก่อนถึงจะทำการยกเลิก Prepayment นั้นได้
บทที่ 5: การผ่านรายการบัญชีไปยังบัญชีแยกประเภท (Payable Transfer to GL)

ก่อนปิด Period สิ่งสำคัญที่ผู้ใช้งานระบบจะต้องกระทำ คือ การผ่านรายการบัญชีไปยังบัญชีแยกประเภท เพื่อทำการบันทึกรายการบัญชีที่เกิดขึ้นลงในบัญชีแยกประเภทของวิทยาเขต และขั้นตอนก่อนการผ่านรายการไปยังบัญชีแยกประเภท มีดังนี้
5.1 Run Program: Invoice Validation
5.2 Run Program: Payables Accounting Process

5.3 Run Program: Unaccounted Transaction Report 

5.1 Run Program: Invoice Validation

เพื่อให้มั่นใจว่าผู้ใช้งานได้ทำการ อนุมัติ (Validate) Invoice ทุกใบของ Period นี้แล้ว ซึ่งจะทำให้การผ่านรายการบัญชีไม่ติด Error ในเรื่องของการอนุมัติ Invoice ไม่ครบ
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หมายเหตุ: เมื่อ Phase = Completed และ Status = Normal คลิก View Output
ตัวอย่าง: Output
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จากตัวอย่าง Hold Name แสดง Dist Variance หมายความว่ายังมี Invoice ที่มียอดไม่เท่ากันระหว่างใน Invoice Amount กับ Invoice Distribution ดังนั้นระบบจะยังไม่ทำการอนุมัติให้ (Validate) ผู้ใช้งานจะต้อง Run รายงานอีก 1 รายงาน เพื่อตรวจสอบว่า Invoice ใบใดที่ไม่สมบูรณ์ หรือ ไม่ถูกต้อง
5.2 Run Program: Payables Accounting Process


เพื่อให้แน่ใจว่าได้ทำการบันทึกบัญชีของรายการที่เกิดขึ้นในทุก ๆ Invoice ของ Period ที่จะทำการ Post ไปยังบัญชีแยกประเภทเรียบร้อยแล้ว 
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ตัวอย่าง: รายงาน Payable Accounting Process
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2 Invoice Price Variance  0L400.11000005104 THB 353271 353271

3 Libilty 01,000,0000.000.2101 THE 54,000.00 54,000.00
O1IAN-07 Invoice VB STy dnrio 134985455 25150

1 charge 01,400,1200.000.5104 THE 700,00 700,00

2 Charge 014001200.000.5104 THE  1,000.00 1,000.00

3 Charge 01,400,1200.000.5104 THE 700,00 700,00

4 Charge 014001200.000.5104 THB  15,000.00 15,000.00

5 Charge 01.400.1200.000.5104 THE  2,000.00 2,000.00

6 Invoice Price Variance  01.400,1200.000,5104 THe 49.00 49.00

7 Invoice Price Variance  01.400,1200.000,5104 THe 70.00 70.00

8  Invoice Price Variance  01.400,1200.000,5104 THe 49.00 49.00

9 Invoice Price Variance  0L400,12000005104 THB  1,050.00 1,050.00

10 Inwoice Price Variance  01.400.1200.000.5104 THB 140.00 140.00

11 Liability 01,000,0000.000.2101 THE 20,758.00 20,758.00
O1-1AN-07 Ivoice A sl e 1276306 182/50

1 charge 014001100.000.5104 THB 5140187 51,401.87

2 Invoice Price Variance  0L400,11000005104 THB  3,598.13 3,598.13

3 Libilty 01,000,0000.000.2101 THE 55,000.00 55,000.00
O1IAN-07 Invoice A muyslm AL i 127/6306(C)  162/50(C)

1 charge 014001100.000.5104 THB  55,000.00 55,000.00

2 Invoice Price Variance  0L400,11000005104 THB  3,850.00 3,850.00

3 Libilty 01,000,0000.000.2101 THE 56,850.00 56,850.00
O1IAN-07 Invoice R sl i 129/6414 18350

1 charge 014001100.000.5104 THB 23,364,489 23,364.49

2 charge 014001100.000.5104 THB  16,822.43 16,822.43

3 Invoice Price Variance  0L400,11000005104 THB 163551 1635.51

4 Invoice Price Variance  0L400,11000005104 THB  1,17757 1177.57

5 Libilty 01,000,0000.000.2101 THE 43,000.00 43,000.00
O1IAN-07 Invoice VB A, nRAG Bwar 4912/082  194/2550

1 charge 011001140.000.5104 THE 15,140,189 15,140.19

2 Charge 011001140.0005104 THE  12,336.45 12,336.45

3 Charge 011001140.000.5104 THE  7,009.35 7,008.35

4 Invoice Price Variance  01100,11400005104 THB  1,099.81 1059.81

5 Invoice Price Variance  01.100.1140.000.5104 THe 863.55 863.55

6 Invoice Price Variance  01.100.1140.000,5104 THe 490,65 490,65

7 Libilty 01,000,0000.000.2101 THE 36,900.00 36,900.00
051AN-07 Invoice VB A RAe Bwnos SOOLO012 22750

1 charge 01.200,1800.000.5104 THE 934.58 934.58

2 charge 012001800.000.5104 THB  39,252.34 39,052.34

O3 chage 012001800.000.5104 THB 560748 5,607.48

4 Charge 01.2001800.000.5104 THB  1,869.16 186,16

5 Charge 01.2001800.000.5104 THB 14087 140087

6 Charge 012001800.000.5104 THE 560748 5,607.48

7 Invoice Price Variance  01.200,1800.000,5104 THe 65.42 65.42

8 Invoice Price Variance  0L200,18000005104 THB  2,74766 2,747.66

o Report Date: 08-MAR-2007 17:34

Page! 2




5.3 Run Program: Unaccounted Transaction Report


กรณีเกิด Error จากการ Run Program: Invoice Validation และ Payables Accounting Process ทั้งสอง Report จะระบุว่าเกิดจากสาเหตุใด แต่จะไม่ได้ระบุว่า Invoice เลขที่ใดที่เกิดปัญหาทำให้ไม่สามารถแก้ไขปัญหาดังกล่าวได้ จึงต้องทำการ Run Program: Unaccounted Transaction Report เพื่อตรวจสอบว่ามี Invoice เลขที่ใดที่ติดปัญหาอยู่บ้าง และติดปัญหาอะไร 
ตัวอย่างปัญหา (Error) ที่อาจเกิดขึ้น 

Dist Variance: ยอดระหว่าง Invoice Amount กับ Invoice Distribute ไม่เท่ากัน 

Insufficient Funds: งบประมาณไม่เพียงพอ

Not Validated: Invoice ใบนี้ ยังไม่ได้ Validate 
Unaccounted: Invoice ใบนี้ ยังไม่ได้บันทึกบัญชี (Create Account)

วิธีการแก้ไข
เมื่อ Run Program: Unaccounted Transaction Report ที่คอลัมน์สุดท้ายจะแสดงสถานะพิเศษ (Exception) ซึ่งแต่ละรายการที่แสดงนั้นจะระบุเลขที่ Invoice ไว้ด้วย การแก้ปัญหาก็คือ ค้นหา Invoice ใบดังกล่าวแล้วทำการแก้ไข หรือหากแก้ไขไม่ได้ให้ทำการ Cancel Invoice ใบดังกล่าว
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ตัวอย่าง: รายงาน Unaccounted Transaction Report

[image: image140.png]Unaccounted Transactions Report

Reporting Level: Operating Unit
Reporting Context: MR Operating Unit
From accounting Date:
To Accounting Date:
Period Name: JAN-07
Chvs. B - umss e Report Date: 15-MAR-2007 D9:45
Page: 1

Unaccounted Invoice

Supplier Supplier  Imoice  Voucher Invoice  Inv Invoice Fo
Narme Number  Number  Number Date  Curr Armourt Nurmber  Exceptions

i o Penns 3301002681 2858 23150 19-1AN-D7 THB  80,000.00 Dist Variance

Fman . aeduues 1313800236 61/13 173/2550 08-DEC-06  THE. 38,800.00 Dist Variance
van, fElad 3031037564 001016 253/50 24-JAN-D7 THB 12,000.00 Dist Variance
Smdon 1312810127 004/181  186/2550 16-DEC-06 THE. 6,550.00 Insufficient Funds

SwAmdu2 1311192439 08/035355  181/2550 20-NOV-D6 THB  60,000.00 Not Validated





5.4 ตัวอย่างการแก้ไขปัญหา

เรียก Invoice เลขที่ติด Error จากการ Run Program: Unaccounted Transaction Report เช่น Invoice Number = 2859 ติด Error = Dist Variance (ปัญหานี้ส่วนใหญ่เกิดจากการที่ผู้ใช้งานลืมคลิกที่ Includes VAT)
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จากตัวอย่างจะสังเกตุว่า Invoice Total กับ Distribution Total มียอดไม่เท่ากัน (ปัญหานี้ส่วนใหญ่เกิดจากการที่ผู้ใช้งานลืมคลิกที่ Includes VAT) โดยปกติจะแก้ปัญหาด้วยการ Reverse รายการแล้ว ทำการบันทึกบัญชี หรือ Matching PO ใหม่ แต่จากตัวอย่างนี้รายการใน Distribution มีเป็นจำนวนมากทำให้ไม่สามารถทำการแก้ไขด้วยวิธีดังกล่าวได้ จึงขอแนะนำให้ทำการ Cancel Invoice ใบดังกล่าว แต่ก่อนการ Cancel Invoice ควรทำการแก้ไข Invoice Number และแก้ไขเลขที่ฎีกาก่อนเพื่อประโยชน์ในการสร้าง Invoice ใบใหม่นั้นจะสามารถใช้ Invoice Number และเลขที่ฎีกาเดิมได้
ตัวอย่าง การเปลี่ยนแปลง เลขที่ฎีกาและ Invoice Number
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จากนั้นสามารถ Create Invoice ใหม่โดยใช้เลขที่ฎีกา และ Invoice Number เดิมได้
ตัวอย่าง การแก้ปัญหาโดยการ Reverse
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ไม่ต้อง Reverse รายการที่เป็น Tax
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กรณี Direct Invoice

[image: image152.png]12,000.00

=] R
Nurr|Type || Amount GL Date Account Tax Cod||Withhold| Includes | Description

1 [item 12,000.00 [24-4AN-2007 [01.400.1140.000.5104010112.00000.0000000.11003.11220.0000.00 7% VAT [y e o viviofaniani |
2 |rax 840.00 [24JAN.2007 [01.400.1140.000.5104010112.00000.0000000.11003.11220.0000.00 [7% VAT

3 Jtem | -12,000.00]01-FEB-2007 ]01.400.1140.000.5104010112.00000.0000000.11003.11220.0000.00 [7% VAT a5 e o viviiofaail s

l+ Jitem | 12,000.00{01FEB-2007 |01.400.1140.000.5104010112.00000.0000000.11003.11220.0000.00 |~ [nsumec

Never Validated No

wPss 1A 1,00 AEYSEION - 9UAATY HNE.AE IUTN 5911 ARA.000.Tey HAn=19L3u 13 A5 - .00000.Undifined. s

View EO View Receipt Allocate Reverse 1 | Click Calculate Tax




ที่สำคัญคือต้องคลิก Include

กรณี Matching PO
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ทำการ Matching PO
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ที่สำคัญคือต้องคลิก Include

ผลลัพธ์ที่ได้จากทั้งสองวิธี
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5.5 การผ่านรายการไปยังบัญชีแยกประเภท (Payables Transfer to General Ledger)
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5.6 การเปิด/ปิดรอบระยะเวลาบัญชี (Periods) 
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Period Status
ระบุ Closed เพื่อทำการปิด Period โดยระบบจะตรวจสอบข้อมูลใน AP ก่อน ถ้ามีรายการที่ยังไม่ Post ไป GL ระบบจะไม่สามารถปิด period ได้
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Close Exceptions Report. Choose the Exceptions button to submit this

report.





หมายเหตุ: เนื่องจากยังมีรายการบางอย่างในระบบที่ยังทำไม่เรียบร้อย เช่น Invoice บางรายการยังไม่ได้ Validate หรือ Invoice บางรายการยังไม่ได้ Create Account หรือยังมีบางรายการไม่ได้ส่งข้อมูลไป GL

[image: image168.png]© Control Payables Periods (NR Operating Unity LFX
Period Number

Fiscal Year
Period Status Period Name Start Date End Date

foven — J oo oo avcewr avcawr
[Jopen M
Jovon | auuu 2007
F 8 [2007 [mavor  Jormavao07 | 1 MAY-2007

.
[Closed | Closed 6 foo7 | MARJTI 1 MAR-2007 1 MAR-2007
[Closed 15| [FEBO7  [01FEB2007  |sBFEB2007
[Cosed o fawr_Joavororumnaor__rromnany
oosos 13 o7 _[occwrfonoecems [ioecas





Click Exceptions เพื่อตรวจสอบว่ายั้งติด Exceptions อะไรบ้างที่ทำให้ไม่สามารถปิด Period ได้ 
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You can check the status of the request in the Requests window.





หมายเหตุ: เมื่อ Click Review ระบบจะ Run Concurrent ให้อัตโนมัติ
Menu -> View -> Requests -> Find
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Menu -> Tools -> Copy File
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ตัวอย่างรายงาน
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หมายเหตุ : จากรายงานหมายความว่ายังมี Invoice ที่ยังไม่ได้ Create Account อยู่ในระบบอีก 3 ใบ 
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